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Manufacturing Analysis Module
The Manufacturing Analysis Module extends the functionality of the Inventory Control and Bill of Material 
modules. The MMAM Module includes a series of screens and reports required by engineering, 
configuration control and manufacturing personnel to analyze the impact of evolving bills of material. The 
MMAM Module also includes tools to help reduce product lead times, associated inventory, review 
engineering changes, track product revisions and minimize phase-out costs.

If the Engineering Module is installed, you can also analyze engineering data, or maintain the workflow and 
routing of change control information.

Module Prerequisites
The Manufacturing Analysis Module has the following prerequisites:

• SYSM (System Control)

• INVM (Inventory Control)

• BILM (Bill of Material)
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Setting Up the Manufacturing Analysis Module
Setting Up the Module provides an overview of how to implement the module. It covers:

• guidelines to consider before you implement the module

• how to prepare your data for loading

• suggested procedures for loading your data

• suggestions for using the module

Although this section provides key information about the Manufacturing Analysis Module, it does 
not explain such manufacturing concepts as material management.

Before You Implement the Module
The Manufacturing Analysis Module provides a series of screens and reports required by 
engineering, manufacturing and configuration control personnel to analyze evolving bills of 
material. To efficiently use this functionality, your bill of material and operations change control 
procedures should be reviewed to verify that data elements required by the module are available. 

Bills of Material Information
• Bills of material information can be maintained from both the Engineering Module (ENGM) and 

the Bills of Material Module (BILM), but it is recommended that only one of these is used for 
maintaining bills. We recommend using the ENGM Module if you need to use reference 
designators or user-defined field capabilities. Procedures should be established for 
determining where a bill of material information is maintained.

• As changes to your products are made, the bills of material are updated. Procedures should 
be established for additions, changes and deletions to your bills of material. 

• Procedures should be established for tracking revision history within the bills of material.

Change Control
• Define your procedures for handling an engineering change request (ECR), including an 

information flow diagram and an ECR form for collecting all related information. These 
procedures should include feedback to originators on the status of the ECR, actions taken on 
the ECR and ECR tracking from initial request through final disposition.

• Define your procedures for handling an approved Engineering Change Notice (ECN). The 
procedures should include a process flow diagram and an ECN form for collecting related 
information, which must include the baseline data required by Fourth Shift. The procedures 
should identify the reason for the ECN and an appropriate cut-in date for implementing the 
engineering change.

• Define classes of engineering changes that reflect the reasons for changes. Inclusion of 
"reason" information allows for subsequent impact analysis of a change class.

Examples of classes include:

Class Description

Product update Product cannot be produced efficiently as released

Quality assurance Product changed to meet functional specs
Manufacturing Analysis 5
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Preparing Your Data for Loading
The guidelines for data preparation are organized around the screens and key fields that are used 
for loading the data. The following suggestions will help minimize data entry time and effort when 
you enter the data during startup.

Preparing for Revision History
Revision history functionality allows you to track the history of bill of material revisions by reviewing 
the sequence of changes to a bill of material, reviewing component assemblies at a revision level 
and printing the "in effect" revision level on the picklist. Revisions to bills of material are often 
called an ECR (Engineering Change Request) or ECN (Engineering Change Notice).

Determine how your company will use revision history in the item master and bill of material to:

• identify the revision as an item on the Item Master

• flag all items affected by the revision on the Item Master

• add the revision as a component to the parent's bill of material at the time the content of the bill 
is modified

• flag each revised component using effectivity date and revision fields on the Bill of Material

Revision Methods
Several methods are available to identify revisions within a bill of material. The approaches differ 
primarily in whether you use the Item Master to identify individual ECN numbers or to identify ECN 
change classes. The ECN number or ECN change class is added to the appropriate bills of 
material and becomes an embedded revision history record.

• Individual ECN Method. The ECN number is added to the appropriate bills of material and 
becomes an embedded revision history record. The ECN impact to items and components can 
be found using the Where Used and Multi-Level Where Used features. You can analyze the 
overall impact of the ECN by determining how many times the ECN number appears as a 
component of different parents. This method allows you to answer these questions: what 
assemblies were impacted by this change and how effective were our efforts to reduce cost for 
assemblies in production.

The Individual ECN method results in a greater number of items on the Item Master (one for 
every ECN number) but minimize the number of text messages (since it is optional).

Marketing requirement Design update is beyond the original product scope

Material availability Alternate part must be used

Reliability Product must pass reliability test

Government requirement Requirements set by the government must be reviewed

Safety requirement Product must meet all safety requirements 

Material cost reduction Cost of parts must be reduced

Administrative Administrative requirements must be met

Engineering release Product is released into Engineering phase

Production release Product is released in Production phase

Class Description
Manufacturing Analysis 6
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See Revision History Method: Individual ECN for more information on this method.

• ECN Change Class Method. The ECN change class is added to the appropriate bills of 
material and becomes an embedded revision history record. The ECN impact to items and 
components can be found using the TXWU (Text Where Used) screen. The TXWU screen 
lists all the places a text number is used within Fourth Shift. Every time an ECN text number is 
found, a revision is occurring for that item. 

The ECN Change Class method results in a greater number of text messages (one for every 
ECN number) but minimize the number of Item Master entries (one for every ECN class).

See Revision History Method: ECN Change Class for more information on this method.

Revision Records
The five-character Pt Use field is used to uniquely define a revision. You use the first three 
characters as a standard prefix (such as REV) for all revisions and the last two characters as the 
unique revision level (A, B, 01, 02 and so on). In this way, revisions are grouped together in bills of 
material and can be isolated for tracking purposes. The prefix is defined in the FS.CFG file by the 
EmbeddedRevPrefix configuration variable. The default is REV.

Revision records may be added to bills of material as resources (Type = R) or References (Type = 
X). The Type, in addition to the Component Sort Basis field on the CNFG screen, determines the 
position of revision records within a picklist. Review the Component Sort Basis options, which 
include:

Suggested Field Values
Use the following suggested field values when entering revision history records on the Item Master 
and Bill of Material for either the individual ECN number method or the ECN change class method.

Item Master Fields

Sort Basis Description

O
(operation)

Sort resources first and then the related components based on the Seqn field. Revi-
sions added as resources are listed before the affected components.

P
(component type)

Sort components by component type first and then the Pt Use and Seqn fields. Revi-
sions added as resources are listed within the component list.

Field Suggested Entry: Based on Method

Item ECN number or Change Classification

Description ECN number or Change Classification description

UM EA

MB B

IT R

St A

Ord Pol 5

Insp Reqd N

Plnr XXX

Buyr XXX
Manufacturing Analysis 7
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Bill of Material Fields

Bill of Material Detail Fields

Specifying Effectivity Dates
Revision history functionality uses effectivity dates and revision levels to determine the following:

• In and Out Effectivity dates are used to determine the cut-in date of an ECN for the affected 
components on a bill of material. The dates can also determine when the revision level 
changes for a bill of material. 

• In Rev and Out Rev fields on the Bill of Material are used to identify the revision level of the 
parent at the time of the In and Out Effectivity dates. 

Determine how your company will use effectivity dates and revision levels. Review the suggested 
field entries for the phased-in and phased-out components.

Pln Pol N

Field Suggested Entry: Based on Method

Pt Use 3-character prefix and rev level

Seqn ØØØ

Component ECN Number or Change Classification

CT D

Quantity 1

QT O

UM EA

MB B

In Effectivity In Effectivity date of ECN number or change class

Out Effectivity Out effectivity date of ECN number or change class

LT Offset Ø

Scr Pct Ø.Ø

Field Suggested Entry: Based on Method

Text ECN number or Change Classification and, description of 
the change

Text No Text number of the associated ECN number or Change 
Classification previously entered

Field Suggested Entry: Based on Method
Manufacturing Analysis 8
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ECN Phased-In Components

ECN Phased-Out Components

Loading Your Data
Once your data has been prepared for entry, use this section to load your data into the 
Manufacturing Analysis module.

A validation tool is identified for each screen or task listed in this section. Use the validation tool 
to double-check the accuracy of the data you have entered. Validation tools include:

• Screen reports. Create these reports by choosing Print from the File menu. For more 
information, see "Screen Reports" in the Fourth Shift Basics manual.

• Print screens. When other report options are not available, you can capture an image of your 
screen and use it to validate your data entry. For more information, see "Using the Print 
Screen Key" in the Fourth Shift Basics manual.

Other validation tools, such as batch processes and data extracts, may also be listed.

1. Configure the Module

Field Suggested Entry: Based on Method

In Effectivity In effectivity date of change number or change class

Out Effectivity Leave as is

In Rev Revision level of the parent after ECN cut-in

Out Rev Blank

Field Suggested Entry: Based on Method

In Effectivity Leave as is

Out Effectivity Out effectivity date of change number or change class

In Rev Revision level of the parent prior to ECN cut-in

Out Rev Revision level of the parent after ECN cut-in

Screen/Task Module Description Validation Tool

Options from the View menu 
(from Bill of Material)

MMAM general options, including record 
sorting and effectivity date filter-
ing of components

print screen

lead time options print screen

configuration option, including Pt 
Use value
The default is Rev. To change 
this, edit the EmbeddedRevPre-
fix configuration variable in the 
FS.CFG file.
Manufacturing Analysis 9
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2. Define Revision Items

3. Add Revision Levels to Bills of Material

4. Add Component Revision Changes

Suggestions for Using the Module
The ways in which the Manufacturing Analysis Module is used vary from company to company. 
The following guidelines may be helpful for using the module in your company.

Access Methods
Several methods are available for accessing the features in the MMAM Module. Access methods 
allow users to choose how to open the Manufacturing Analysis Module features. See "Access 
Methods" in the Engineering manual for more information.

Navigation and Selection Options
Several methods are available for navigating and selecting within the Manufacturing Analysis 
Module. Navigational and selection methods include the following:

• Menu Options. Use the mouse to select an option from a menu. Click the menu title to view 
the options for each menu. Menu options may not always be available. If an option is 

Screen/Task Module Description Validation Tool

Item Master ENGM or 
INVM

items for each ECN class or ECN 
number

screen report

Item Master ENGM or 
INVM

Rev field changes for each 
affected item to reflect the new 
revision

screen report

Screen/Task Module Description Validation Tool

Bill of Material ENGM or 
BILM

addition of revision history com-
ponent for each affected parent 
revisions

screen report

Production tab from Bill of Mate-
rial or Bill of Material Detail 
screen

ENGM or 
BILM

component text and detail infor-
mation

print screen

Screen/Task Module Description Validation Tool

Bill of Material, sorted by In 
Effectivity Date 

ENGM addition of component In Rev 
revision changes to match their 
effectivity dates

screen report

Bill of Material, sorted by Out 
Effectivity Date 

ENGM addition of component Out Rev 
revision changes to match their 
effectivity dates

screen report
Manufacturing Analysis 10
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unavailable, the text is grayed and the option cannot be selected. Click on the menu option to 
start the action listed. 

• Toolbar Buttons. Use the mouse to select a button from the main toolbar. The toolbar 
provides a quick way to access some of the most frequently used features of the module. 

• Mouse Conventions. Use the mouse to “drag and drop” components from one category to 
another. For example, to add a user to a group, simply select the user and then drag and drop 
the user into the specified group. Click the left or right mouse buttons to select open menus 
and options.

• Keyboard Conventions. You can use the standard keyboard keys to navigate within the 
system. Keyboard conventions are key or key combinations that allow you to carry out a 
command or action.

Menu and Toolbar Options
Menu options and toolbar buttons provide several methods for accessing the module features. The 
menu bar is located at the top of the application window. The toolbar is located below the menu 
bar at the top of the application window. Options may vary based on available features and for 
inquiry-only features. 

Menu Options
The following menu options are available:

Menu Option Description

File Open Opens based on specified information.

Go to Frame Allows navigation to the module features.

Print Preview Displays a report available for the specified parent item.

Quick Print Displays record selection options available to print an ad-hoc report.

Save Settings Saves all option settings for the application. If you close an application 
without saving the settings and you have not selected the Save Settings on 
Exit option on the Options menu, you lose all settings changes you did not 
save previously.

Exit Exits you from the application.

Edit Find Opens the Find application that allows you to search for a specific compo-
nent based on search criteria.

Find Next Repeats the search using the criteria defined in the Find feature.

Select All 
Records

Selects all records for the current parent item.

Zoom Expands the viewing capacity of the selected information.

Columns Allows you to specify column layout

View Refresh Clears the active field.

Graphical Bill 
of Material

Opens the Graphical Bill of Material dialog which allows you to view the bill 
of material in a graphical hierarchy.

Shop Calendar Opens the Shop Calendar, which allows you to calculate shop days based 
on specified criteria and view embedded revision information.

Properties Allows you to define a bill of material filter based on component type 
related criteria, define available quantity and set cost definitions.
Manufacturing Analysis 11
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Toolbar Buttons
The following toolbar buttons are available:

Revision History Method: Individual ECN
The Individual ECN revision history method involves defining each ECN number as an item on the 
Item Master. The Individual ECN method results in a greater number of items on the Item Master 
(one for every ECN number) but minimize the number of text messages (since it is optional).

Revision history using the individual ECN method looks similar to the following:

Options Allows you to specify general layout and lead time options and to review 
configuration settings.

Help Help Topics Opens the online help.

Setting Up the 
Module

Opens the help at the Setting Up the Module section.

About MMAM Displays information about the release level.

Toolbar Options Description

Go to Frame Allows navigation to the module features.

Open Opens based on specified information.

Print Preview Generates a report based on the current column settings and displays report on 
screen for review. Print the generated reports using your standard Windows print-
ing procedures.

Quick Print Displays record selection options available to print an ad-hoc report.

Find Opens the Find application that allows you to search for specific information in 
the displayed list.

Graphical Bill of Mate-
rial

Opens the Graphical Bill of Material dialog that allows you to view the bill of mate-
rial in a graphical hierarchy.

Shop Calendar Opens the Shop Calendar, which allows you to calculate shop days based on 
specified criteria and view embedded revision information.

View Allows you to select a previously specified view using a drop menu.

Save Current View Saves the current layout of fields into a view.

Properties Allows you to define a bill of material filter based on component type related crite-
ria, define available quantity and set cost definitions.

Refresh Clears the active field.

Apply Exclusions Allows you to filter records based on specified criteria.

Last Message Displays the previous message that was in the Status Bar, which is located at the 
bottom of the form.

Help Displays the help contents.

Menu Option Description
Manufacturing Analysis 12
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Method Example
Example ECN items look similar to the following:

The following bill of material shows that component U218 changes to U392 on 08/30/1998. Also, 
the manufacturing revision (ECN 98 and ECN 99) of the parent assembly changes from "A" to "B" 
on that same date.

The actual ECN change classification and change description can be optionally added as a text 
message on the bill of material. The Text No may be reused on all assemblies impacted by that 
same ECN. 

Revision History Method: ECN Change Class
The ECN Change Class revision history method involves defining an ECN change class as an 
item on the Item Master. The ECN Change Class method results in a greater number of text 
messages (one for every ECN number) but minimize the number of Item Master entries (one for 
every ECN class).

Item Description

ECN 98 Engineering Release

ECN 99 Production Release

ECN 100 Quality Assurance

Pt Use Component CT Eff In / Eff Out In Rev / Out Rev

00001 U218 N 022898   083098 A    B

00001 U392 N 083098   123179 B

Rev A ECN 98 R 022898   083098 A    B

Rev B ECN 99 R 083098   061099 B

Item Master

Bill of Material : Item 1

ECN  98

ECN  98

Item Master

Bill of Material : Item 2

ECN  99

ECN  99

Item Master

Bill of Material : Item 3

ECN  100

ECN  100

ECN
Class 1

Text Number 90
(optional)
Manufacturing Analysis 13
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Revision history using the ECN change class method looks similar to the following:

Method Example
Example ECN change classifications look similar to the following:

The following bill of material shows that component U218 changes to U392 on 08/30/1998. Also, 
the manufacturing revision (ECN Class 1 and ECN Class 5) of the assembly changes from "A" to 
"B" on that same date.

The actual ECN number and change description are added as a text message on the bill of 
material. The Text No is reused on all assemblies impacted by that same ECN. 

Managing Lead Times

Item Description

ECN Class 1 Engineering Release

ECN Class 2 Product Update

ECN Class 3 Quality Assurance

ECN Class 4 Safety Requirement

ECN Class 5 Government Regulation

Pt Use Component CT Eff In / Eff Out In Rev / Out Rev

00001 U218 N 022898   083098 A    B

00001 U392 N 083098   123179 B

Rev A ECN Class 1 R 022898   083098 A    B

Rev B ECN Class 5 R 083098   061099 B

Item Master

Bill of Material : Item 1

ECN
Class 1

ECN  98 Text Message 90

Bill of Material : Item 2

ECN
Class 1

ECN  99 Text Message 91

Bill of Material : Item 3

ECN
Class 1

ECN  100 Text Message 92

ECN
Class 1
Manufacturing Analysis 14
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The Lead Time Analysis feature is used to reduce lead times by simulating the affect of "what-if" 
changes to item lead times and component lead time offsets in order to examine the effects of the 
simulated changes on the end-item's total lead time. Using the Lead Time Analysis feature, you 
can answer the following business questions:

• Which components do we need to focus on to reduce total product lead time?

• Are the Lead Time Offset values set to correctly reflect the point in time that components are 
needed to fulfill an order?

The Lead Time Analysis graph displays the aggregate lead time of an assembly. Changing the 
lead time of a component will change the simulated lead time for all occurrences of that 
component in the multi-level bill of material.

Critical Path
A methodical approach to lead time analysis and reduction is to work the critical path and simulate 
changes to the lead times. Starting with the longest lead time components on the critical path, 
review and update the lead times. After each update, recalculate the critical path and continue the 
process, starting again with the longest lead time. A component's lead time should stand "the test 
of reasonableness." 

Components on the critical path are flagged with a "*" symbol and highlighted for fast identification.

Managing Inventory Costs
After the lead time analysis is complete and component lead times have been updated, use the 
Material Exposure button to graphically review the product cost buildup over its lead time. Using 
the Material Exposure feature, you can answer the following business questions:

• How do we respond more quickly to requests for unplanned "impact builds" from customers?

• What is the worst case investment we have to make to reduce the effective Lead Time of a 
product 25% or 50%?

• Are there components within a product whose low cost does not justify its negative impact on 
Lead Time?

You use the Properties dialog to set the cost definitions that are used during the Material Exposure 
analysis. You may review cost build up information based on different views, such as material cost 
build ups, overhead absorption profiles or labor application phasing.

Cost Calculations
Cost calculations in Material Exposure analysis use Standard Costs (Cost Type = 0) and include 
component Scrap and Yield. Costs calculated include the Cost Per Assembly, Cumulative Cost 
and % of Cost.

For example, you have a product whose lead time is 65 days, constrained by material availability. 
Your competition is able to regularly react to impact orders in 50 days. Determine the maximum 
out-of-pocket investment required to respond to a 20 percent increase to planned product 
shipments within 40 days of the demand. First, you need to determine what the product's per-unit 
cost is at 40 days of the current 65-day lead time. To view out-of-pocket costs, set the cost 
definitions to include only Material costs (exclude Labor and Overhead cost components). The 
Material Exposure graph and grid present calculated costs similar to the following:

LT Days LT OS Component
Cumulative 

Cost % of Cost

40 0 U218 72.27 13.5
Manufacturing Analysis 15
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So, for a maximum investment of $72.27 (which is 13.5% of the material content of the product) 
you can reduce your product lead time by 31%, which is (65-45)/65. This is the ‘worst case’ 
investment required. The $72.27 per unit cost may be reduced with appropriate focused supplier 
negotiations. The total investment would be the incremental build quantity multiplied by the post-
negotiation costs per unit.

Flattening Bills of Material
Engineering teams usually have change control management in mind, and so the bills of material 
that they release typically include more levels than the manufacturing team would like to build. For 
the manufacturing team, more levels mean more cost. The use of phantom assemblies allows 
manufacturing to eliminate unnecessary assemblies and “flatten the bills’ for manufacturing. 

You can review the effectiveness of flattening your bills of material by choosing to “explode 
phantoms,” a feature on Bill of Material, Multi Level Bill and Summarized Bill of Material. When 
phantoms are exploded on the Bill of Material (single level) the bill reflects what would be seen on 
a manufacturing order picklist.

For example, when a single level bill with phantom subassemblies is exploded, it presents 
components from subordinate subassemblies. You can create a User Defined View for the Bill of 
Material (single level), adding the Level and Parent Fields, which will show the effective levels and 
phantom Assemblies. A bill of material using this concept would look similar to the following:

Single Level Bill of Material for parent Product-1:

Multi-level Bill of Material for parent Product-1:

Level Parent Component CT

1 PRODUCT-1 ASSY-1 N

1 PRODUCT-1 ASSY-1 P

Level Parent Component CT

1 PRODUCT-1 ASSY-1 N

1 PRODUCT-1 ASSY-1 P

2 ASSY-1 COMP-1 N

2 ASSY-1 COMP-2 N

2 ASSY-1 SUBASSY-1 P

3 ASSY-1 COMP-3 N

3 ASSY-1 COMP-4 N

2 ASSY-1 SUBASSY-2 N

3 ASSY-1 COMP-5 N

3 ASSY-1 COMP-6 N
Manufacturing Analysis 16
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Single Level Bill of Material for parent Product-1 – Explode Phantoms:

The presentation of Level 2 and 3 components within the single level bill of material indicates that 
the multi-level bill of material has been flattened to one level.

Comparing Bills of Material
Comparison Bills can be used to compare different assemblies within your bills of material. If you 
maintain revision history within your bills of material, you can display bill of material changes from 
one revision level to another revision level. Comparison Bills are then used to compare the same 
assembly at two different revision levels or between two different parent assemblies at different 
revision levels. With this information you can easily obtain material lists necessary for finished 
inventory, field or work-in-process update kits linked to the correct revision. 

For example, a parent item can have three revision levels: A, B and C with the following 
Component Effectivity Dates for the revision levels:

You can view the components that are being changed from one revision to the next revision. For 
example, components for a parent item that have changed between Rev B and Rev C are listed on 
the Comparison Bill of Material:

Level Parent Component CT

1 PRODUCT-1 ASSY-1 N

1 PRODUCT-1 ASSY-1 P

2 ASSY-1 COMP-1 N

2 ASSY-1 COMP-2 N

2 ASSY-1 SUBASSY-1 P

3 ASSY-1 COMP-3 N

3 ASSY-1 COMP-4 N

2 ASSY-1 SUBASSY-2 N

Rev Description In Eff Out Eff

A Engineering Release 022898 083098

B Design Update 083098 061099

C Functionality Add 061099 123179

Pt Use Seq Component In Eff / Out Eff
In Rev / Out 

Rev

00001
00001

ASSY
ASSY

PCB26
PCB27

022898    061099
061099

A C
C

00076 ASSY J553 061099 C

REV B 001 Design Update 083098    061099 B C

REV C 001 Functionality Add 061099    123102 C
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The combination of Pt Use + Seq + Component is the basis of the Comparison Bill. When 
comparing different assemblies, differences in component properties having the same Pt Use + 
Seq are highlighted on screens and reports.

Assessing the Potential Impact of Unplanned Orders
The Summarized Bill of Material feature allows you to simulate the production of a quantity of an 
item. Components are hypothetically consumed and costs are incurred based on the user-defined 
criteria specified for the Available Quantity and Cost Definitions.

For example, if a customer wants 150 of parent PWA27 inside the product lead time, and material 
availability is the constraining factor, you need to answer the following questions.

• Is there sufficient Available Inventory (On Hand + Incoming — Allocated) to satisfy the 
unplanned demand?

• What inventory in addition to that considered "available" is required to satisfy the potential 
order?

• How much of that "required inventory" must be expedited?

• What are the projected minimum out-of-pocket costs to be incurred?

Specifying Simulation Criteria
You can redefine the Available Inventory definition and specify the Costs for the analysis based on 
the importance of the impact order being simulated. Simulation criteria is set using the Available 
Quantity and Cost Definition tabs on the Properties dialog.

For example, to determine the out-of-pocket costs in fulfilling an impact order with inventory from a 
specific warehouse, set the cost definitions to include only direct material as follows:

• Available Quantity. Use the default setting On-Hand + In-Inspection — Allocated. For stock 
locations, select "Include Only these Locations" and select the desired locations. To select all 
the bins within Warehouse V1, select Stock=V1 and enter Bin = *.

• Cost Definition. To determine out-of-pocket costs, set the cost definitions to include only 
Material costs (exclude Labor and Overhead costs.

Cost calculations for Summarized Bill analysis include component Scrap and Yield. 

Specify the product quantity and consume type using the Prod Qty and Consume fields for the 
analysis:

• Prod Qty. Input the size of the Impact Order.

• Consume. Select the types of inventory you want the simulation to consume. Consume types 
include: Buys only, Makes and Buys (no phantoms), All or None.

Simulation Results
Summarized Bill uses the entered simulation criteria to calculate quantities and costs, which 
include:

• anticipated out-of-pocket (required) costs that could be used in customer price negotiations

• items consumed from available inventory

• item expedite lists sorted by lead time

The following views are available to display simulation results based on different sort options:

• item

• required quantity
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• lead time

• required cost

• consumed cost

Each view has a corresponding report that provides inventory and cost centric formats.

Minimize Obsolete Inventory Costs
The Summarized Bill of Material feature may be used to determine optimum build quantities during 
a product phase-out. The goal in a product phase-out is to build the correct quantity of the item; 
minimizing new procurement while maximizing consumption of on-hand inventory.

Use the following technique to maximize consumed inventory and minimize inventory required:

• Perform a series of production analyses varying the Prod Qty for the item being phased out.

• Review the Average Cost Required, Average Cost Consumed and Average Cost Total.

• Determine the inflection point where the maximum inventory is being consumed with the 
minimum inventory required.

• Calculate the Difference in Cost.

Constant Product Quantity Increments
If the incremental increase in successive Prod Qty values is constant, the calculation of the 
Difference in Costs reflects the approximate optimum build quantity when it is at its maximum.

For example, the following chart represents information that could be calculated on Summarized 
Bill for an item.

Difference in Cost is calculated by subtracting the previous Prod Qty's Average Cost from the 
current Prod Qty's Average Cost for each Prod Qty. For example, the Difference in Cost for 
Prod Qty = 150 is 26 (226-200).

This example shows that the maximum Difference in Cost is 47 and therefore you should 
produce approximately 150-200 units of the item during phase-out.

Random Product Quantity Increments
If the incremental increases in successive Prod Qtys are not constant, a graphical depiction of 
costs can be used to calculate the optimum build quantity. A graph provides a way to visually 
observe the inflection points.

Prod Qty

Average 
Cost 

Required
Average Cost 

Consumed
Average 

Cost Total
Difference in 

Cost

100 0 226 226 —

150 26 200 226 26

200 73 153 226 47

250 101 125 226 28

300 120 106 226 19
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A closer estimate of the optimum production quantity can be determined by analyzing the Prod 
Qty range of 125-195 using smaller increments. For example, the following chart represents 
Summarized Bill information using increments of 10:

Details of the product quantity and cost differences include:

Generating Reports
The screens and tasks in the Manufacturing Analysis (MMAM) Module generate a number of 
reports. 

Sorting Options for Summarized Bill of Material Reports

Prod Qty

Average 
Cost 

Required

Average 
Cost 

Consumed
Average 

Cost Total
Difference 

in Cost

125 9 217 226 —

135 11 215 226 2

145 20 206 226 9

155 32 194 226 12

165 43 183 226 11

175 53 173 226 10

185 61 165 226 8

195 69 157 226 8

125     135     145     155     165     175     185     195

Optimum Build Analysis

Prod Qty
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8
6
4
2
0
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Several sorting options are available for the Summarized Bill of Material report. Based on the 
selected standard view and sort option, the following Summarized Bill of Material reports are 
available:

* = Items, costs and quantities are sorted in descending order. Other sort orders include QT (I,O) 
and MB (S,M,B).

System Administration
The System Administration manual outlines the tasks involved in maintaining Fourth Shift. The 
Manufacturing Analysis Module includes special considerations in the area of backups, 
configuration variables, server processes, and security.

Configuration Variables
The following configuration variable is used in the Manufacturing Analysis Module and can be 
customized, if desired:

ODBC Server Process
To successfully run the MMAM Module, you need to have the ODBC server process running. The 
MMAM Module uses the ODBC Server process to access the Fourth Shift database.

Security

View Sort* Available Reports

Item Item All Items with Cost Data 
All Items with Inventory
Required Items with Cost Data
Required Items with Inventory

Required Qty QT, MB, Quantity Required All Items with Cost Data 
All Items with Inventory
Required Items with Cost Data
Required Items with Inventory

Lead Time MB, Lead Time All Items with Cost Data 
All Items with Inventory
Required Items with Cost Data
Required Items with Inventory

Required Cost QT, MB, Required Cost All Items with Cost Data 
All Items with Inventory

Consumed 
Cost

QT, MB, Consumed Cost All Items with Cost Data 
All Items with Inventory

Variable Description

EmbeddedRevPrefix Bill of material embedded revision level prefix. Default is “Rev” or value defined in 
the FS.CFG file.

MMAMDir Manufacturing Analysis database location
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Security rules for accessing the Manufacturing Analysis features should be assigned based on the 
requirements for each user. Use the PASS (Password Maintenance) screen to assign each user 
identifier a password and access code. Use the FCMT (Function Code Maintenance) screen to 
associate function codes with access codes.

Screen/Task Security for

CMND DOS Command Shell

PROG Fourth Shift Program Execution

ALT1 Lead Time Analysis from the Lead Time tab in the Multi-Level Bill feature

MEX1 Material Exposure from the Lead Time tab in the Multi-Level Bill feature
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Bill of Material
Bills of material are constructed one level at a time by entering a parent item and its first-level components. 
As you progress through your product structure entering parent-component information, you automatically 
build the multi-level bill of material for an end-item. While building your bill of material, you can view related 
item detail, such as packaging, planning and stock status information.

Bill of Material displays parent and component item information in both a graphical hierarchy and in a table 
(row by column) format. The table format can be customized, for example, to add a second row of column 
headings, add or remove columns or change the column width.

Features available are based on user job functions:

Reports

Bill of Material Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists the bill of material.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Bill of Material

Fields
Buyr

Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Access from Features

ENGM Module Set up and maintain the single level bills of material, assign reference designa-
tors and enter component detail information

MMAM Module View the single level bills of material

Report Title

Bill of Material
Lists the bill of material.
Manufacturing Analysis 23



Fourth Shift Release 8.00 Bill of Material
Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE
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CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.
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An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.
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Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Fixed LT
Fixed Lead Time is the number of working days required for setup and queue time used in 
planning an order. It is added to run lead time and inspection lead time to estimate planned 
lead time for an order. Entry is up to 3 numbers.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; IPPD; Item 
Availability; Item Browse Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-
Level Bill; Multi-Level Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill 
of Material Report; Where Used; Workcenter Master

In Effectivity
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
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Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Out Effectivity
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE
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Pln Pol
Planning Policy is used to determine the type of demand an item generates for its 
components based on planned orders. The codes are:

N = Normal. 
Planned and released orders for this item produce "normal" dependent demand for its 
components.

P = Production Plan. 
Planned orders for this item produce a "production forecast" for its components. 
Orders cannot be released for this item. 

F = Final Assembly. 
Planned and released orders for this item create "final assembly" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

D = Distribution. 
Planned and released orders for this item produce "distribution" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

M = Master Scheduled. 
Planned and released orders for this item produce "normal" dependent demand for its 
components. Planned orders must be manually scheduled within the item's Plng Fnc 
(planning fence).

It is recommended that you only use the "N" code until the master planning capability is 
installed in your system.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; IORD; IPPD; Item Browse 
Detail; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level Where Used; 
Production; Summarized Bill; Where Used

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master
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Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Pt Use Defines Embedded Revision
Pt Use Defines Embedded Revision specifies the three key characters in the Pt Use field 
that uniquely identify revision history components in a bill of material. The recommended value 
is REV. If REV has previously been used to define a workcenter, another identification prefix 
must be used.

Where Used: Bill of Material; Summarized Bill

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE
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Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Ref Des Count
Reference Designator Count is the total number of unique reference designator identifiers 
entered as Reference Designators associated with a component. For example, the 
Reference Designator Count = 3 for reference designators entered as a range of D1-D3 for a 
specified component.

Where Used: Bill of Material; Comparison Bill; Multi-Level Bill; Where Used

Reference Designators
Reference Designators are unique identifiers which allow engineers to assign control 
information such as device callouts to a component within a Bill of Material. Ranges can be 
used to organize multiple sequential reference designator identifiers. Entry is up to 10 
characters.

Where Used: Bill of Material; Comparison Bill; Engineering; Exceptions; Multi-Level Bill; 
Where Used

Run LT
Run Lead Time is the average number of shop days required for a manufacturing run or 
vendor lead time and is used in planning an order. Run Lead Time is added to fixed lead time 
and inspection lead time to estimate planned lead time which serves to time order release. 
Decimal places for fractional days allowed. MRP Planning uses fractional days as reference 
and plans using the next whole day increment. For example, if you specify Run LT = 2.1, MRP 
Planning assumes Run LT = 3 for calculation purposes. Entry is up to 8 numbers.

Note: Lead times established for an item are considered to be 0 when the item is used as a 
phantom (CT = P) in a bill of material.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; IPPD; Item Availability; Item Browse 
Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level 
Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill of Material Report; 
Where Used; Workcenter Master
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Rv
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Total LT
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
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Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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Comparison Bill
Comparison Bill is used to compare bills of material based on parent items or by component effectivity 
date. For example, you can compare Parent 1 to itself, based on different revisions (component effectivity 
dates) or you can compare Parent 1 and Parent 2 from different bills of material.

Comparison Bill compares parent, point of use, sequence and component item information in a table (row 
by column) format based on the information entered in the Parent 1, Parent 2 and Component Effectivity 
Dates fields. Use the Hide All Matching Records and Hide All Unmatching Records options to easily 
compare the bills of material information.

The Comparison Bill functionality is the same regardless of how it is accessed.

Reports

Comparison Bill Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists changes to the product structure, including revision history.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Comparison Bill

Fields
Component

Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 

Report Title

Comparison Bill
Lists changes to the product structure, including revision history.
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Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used
Manufacturing Analysis 35



Fourth Shift Release 8.00 Comparison Bill
Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
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Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
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Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

In Effect
In Effectivity is the first In Effectivity date, which should be considered valid to display for this 
bill of material. Entry is 6 numbers in the system date format. Default is 010180.

Where Used: BILI; BILL; Comparison Bill

In Effectivity
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

In Rev
In Revision Level indicates the level of documentation for which the parent-component 
relationship becomes effective. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Out Effect
Out Effectivity is the last Out Effectivity date which should be considered valid to display for 
this bill of material. Entry is 6 numbers in the system date format. Default is 123179 when U.S. 
date format is used.

Where Used: BILI; BILL; Comparison Bill
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Out Effectivity
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE

Out Rev
Out Revision Level indicates the level of documentation for which the parent-component 
relationship is no longer in effect. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Parent Item
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Production Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
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structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE
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QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Ref Des Count
Reference Designator Count is the total number of unique reference designator identifiers 
entered as Reference Designators associated with a component. For example, the 
Reference Designator Count = 3 for reference designators entered as a range of D1-D3 for a 
specified component.

Where Used: Bill of Material; Comparison Bill; Multi-Level Bill; Where Used

Reference Designators
Reference Designators are unique identifiers which allow engineers to assign control 
information such as device callouts to a component within a Bill of Material. Ranges can be 
used to organize multiple sequential reference designator identifiers. Entry is up to 10 
characters.
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Where Used: Bill of Material; Comparison Bill; Engineering; Exceptions; Multi-Level Bill; 
Where Used

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE
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Summarized Bill
Summarized Bill allows you to perform "what if" cost and inventory impact analysis by comparing multi-
level bills of material where each of the components is listed once with an aggregated quantity. 
Summarized Bill is used to:

• plan for optimal material usage during product phase-out

• assess cost/inventory implications of unplanned impact orders

• generate prioritized material expedite lists

Summarized Bill displays component item information in a table (row by column) format based on the 
information entered in the Parent and Component Effectivity Date fields. 

Features available are based on user job functions:

When accessed from the MMAM Module, Summarized Bill analysis calculates summarized, consumed 
and required quantity and cost information based on a specified Prod Qty (production quantity) value. 
Information calculated includes:

The Summarized Bill of Material reports available can be sorted in a variety of ways. See Generating 
Reports in the Setting Up the Manufacturing Analysis Module section of the Manufacturing Analysis 
manual for more information.

Reports

Summarized Bill Reports

Access From Features

ENGM Module Present a multi-level bill where each of the components is listed once with an 
aggregated quantity. Quantities are aggregated based on make buy (MB), quan-
tity type (QT) and component type (CT).
For example, you may need a purchase requisition for materials still in the engi-
neering phase that means the materials are not in the Fourth Shift inventory. You 
can use the summarized bill of material with aggregated quantities to show your 
material requirements in order to get a purchase requisition.

MMAM Module Present a multi-level bill by specifying a product quantity and an item type to con-
sume. Choose to view data from several pre-defined views, such as Summarized 
Bill by Lead Time or Required Quantity.

Information 
calculated Description

Summarized total quantity/cost needed to produce the Prod Qty specified, taking scrap and 
yield into account.

Consumed quantity/cost taken from Available inventory to fulfill the production of the Prod 
Qty specified

Required quantity/cost, in addition to the consumed amount, needed to fulfill the production 
of the Prod Qty specified
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To generate the report, choose Print Preview from the File menu.

Report Description
Lists inventory and cost data for items.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Summarized Bill

Fields
Allocations

Allocated is the number of units committed to released customer orders.

Where Used: Inventory Status; Item + Quantity; Item Availability + Quantity; Summarized 
Bill

Available
Available is the calculated amount of item inventory that may be applied to satisfy the 
Summarized Quantity of a component necessary to build the Prod Qty of a parent assembly. 
Available inventory types include: On-Hand, On-Hold, In-Inspection, In Shipping.

Where Used: Summarized Bill

Available Qty
Available Quantity is the user-defined formula used to calculate the quantity available for the 
purpose of fulfilling the simulated Prod Qty. Available Quantity is increased when the 
following are selected:

On-hand (O)
In-Inspection (adjusted for yield) (I)
On-Hold (H)
In WIP (W)
In shipping (S)
On-Order (R)

Report Title

Summarized Bill
Lists inventory and cost data for items.
Manufacturing Analysis 44



Fourth Shift Release 8.00 Summarized Bill
Available Quantity is decreased when the following is selected:

Allocations from other orders (A)
The Available Quantity definition is displayed using the abbreviations in parenthesis. The 
default calculation is:

[On-Hand + (In-Inspection * Yield)] - (Allocations from other 
orders)

Where Used: Material Exposure; Summarized Bill

Average Cost Consumed
Average Cost Consumed is the average calculated value of the Consumed Quantity in 
order to fulfill the simulated Prod Qty. The calculation is:

Extended Cost Consumed / Prod Qty

Where Used: Summarized Bill

Average Cost Required
Average Cost Required is the average calculated value of components needed in addition to 
the Consumed Quantity in order to fulfill the simulated Prod Qty. The calculation is:

Extended Cost Required / Prod Qty

Where Used: Summarized Bill

Average Cost Total
Average Cost Total is the average total calculated value of components needed to fulfill the 
simulated Prod Qty. The calculation is:

Average Cost Required + Average Cost Consumed

Where Used: Summarized Bill

Buyr
Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
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Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 
POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
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Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

Consume Avail
Consume Avail defines what types of items are obtained from the Available Quantity to fulfill 
the simulated Prod Qty.

0 = Buy items only
1 = Make/Buy items (no phantoms)
2 = All items
3 = No items

Where Used: Summarized Bill

Consumed Item Cost
Consumed Item Cost is the per unit total rolled cost of an item as displayed on the ITMC 
(Item/Work Center Cost Data) screen at the time it is displayed. The consumed item cost 
answers the "what if" question of how much did it cost to produce an item currently available to 
be consumed.

Where Used: Summarized Bill
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Consumed Quantity
Consumed Quantity is the number of components taken from Available Quantity to fulfill the 
simulated Prod Qty.

Where Used: Summarized Bill

CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.
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W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
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Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Effectivity Date
Effectivity Date is the effectivity date specified the last time the CROL task was run.

Where Used: CMLB; CSLB; Summarized Bill

Extended Cost Consumed
Extended Cost Consumed is the calculated value of all components taken from Available 
Quantity in order to fulfill the simulated Prod Qty. The calculation is:

Consumed Quantity * Cost Definition of Standard Cost

Where Used: Summarized Bill

Extended Cost Required
Extended Cost Required is the calculated value of all components needed in addition to 
those taken from Available Quantity to fulfill the simulated Prod Qty. The calculation is:

Required Quantity * Cost Definition of At This Level Cost

Where Used: Summarized Bill
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Extended Cost Total
Extended Cost Total is the total calculated value of the items needed to fulfill the simulated 
Prod Qty. The calculation is:

Extended Cost Consumed + Extended Cost Required

Where Used: Summarized Bill

Inventory
Inventory identifies the quantity of inventory stored in a stock and bin location. Inventory types 
includes allocated, in-inspection, in shipping, internal WIP, external WIP, on hand, on hold and 
on order.

Where Used: Summarized Bill

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Manufacturing Analysis 51



Fourth Shift Release 8.00 Summarized Bill
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

Make / Buy Cost
Make / Buy Cost is the user-defined formula used to calculate the Total Cost for make and 
buy items. Cost definitions for make and buy items can include the following costs:

Material (M)
Labor (L)
Variable overhead (V)
Fixed overhead (F)

The Make / Buy Cost definition is displayed using the abbreviations in parenthesis. 

Where Used: Material Exposure; Summarized Bill

Matl Cost
Material Cost is the cost of an item, and normally applies to purchased items only. Material 
Cost can be specified for each Cost Type established for an item. Entry is up to 16 numbers.

Where Used: ITCI; Item Master; ITHC; ITMC; Multi-Level Costed Bill; QUOI; QUOT; 
Summarized Bill

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.
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S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

On Order
On Order Quantity is the total number of items on open or released manufacturing and 
purchase orders (Ln# Sta = 3 or 4).

Where Used: Inventory Status; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Shortages; Location Index; Material Shortages Detail; Production; Shortages by 
Order; SSII; Summarized Bill

Order Related Total
Order Related Total is the total cost of all components (Quantity Type = O) and their 
subordinates. The Order Related Total cost is included in the Extended Cost and in the 
Average Cost and is amortized over the parent Prod Qty.

Where Used: Summarized Bill

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Pln Pol
Planning Policy is used to determine the type of demand an item generates for its 
components based on planned orders. The codes are:

N = Normal. 
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Planned and released orders for this item produce "normal" dependent demand for its 
components.

P = Production Plan. 
Planned orders for this item produce a "production forecast" for its components. 
Orders cannot be released for this item. 

F = Final Assembly. 
Planned and released orders for this item create "final assembly" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

D = Distribution. 
Planned and released orders for this item produce "distribution" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

M = Master Scheduled. 
Planned and released orders for this item produce "normal" dependent demand for its 
components. Planned orders must be manually scheduled within the item's Plng Fnc 
(planning fence).

It is recommended that you only use the "N" code until the master planning capability is 
installed in your system.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; IORD; IPPD; Item Browse 
Detail; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level Where Used; 
Production; Summarized Bill; Where Used

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Prod Qty
Production Quantity is the number of parent items for which you want to analyze component 
impact. Entry is 1 - 9999999999.

Where Used: Summarized Bill
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Pt Use Defines Embedded Revision
Pt Use Defines Embedded Revision specifies the three key characters in the Pt Use field 
that uniquely identify revision history components in a bill of material. The recommended value 
is REV. If REV has previously been used to define a workcenter, another identification prefix 
must be used.

Where Used: Bill of Material; Summarized Bill

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Required Item Cost
Required Item Cost is the per unit cost calculated at the time it is displayed based on the 
multi-level bill content and the At This Level Costs defined at the time of the simulated cost 
roll. The required item cost answers the "what if" question of how much will it cost if the 
required item had to be built.
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Where Used: Summarized Bill

Required Quantity
Required Quantity is the number of components needed in addition to the Consumed 
Quantity to fulfill the simulated Prod Qty.

Where Used: Summarized Bill

Rev
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used

Stock/Bin Locations
Available Stock/Bin Locations is the user-defined formula to specify which stock and bin 
locations are calculated in Available Quantity. You can specify to include the following:

all stock / bin locations
include only specific stock / bin locations 
exclude specific stock / bin locations

Default is to include all stock / bin locations in the available quantity.

Where Used: Summarized Bill

Summarized Quantity
Summarized Quantity is the total number of components needed to fulfill the simulated Prod 
Qty.

Where Used: Summarized Bill

Total LT
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used
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UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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Multi-Level Bill
Multi-Level Bill is used to view a parent items' multi-level product structure as of a user-specified effectivity 
date. You can view a flattened bill format by exploding phantom components. Multi-Level Bill also allows 
you to view the complete item change history as of a specific revision level or effectivity date.

Multi-Level Bill displays component item information in a table (row by column) format based on the 
information entered in the Parent and Component Effectivity Date fields.

The Multi-Level Bill functionality is the same regardless of how it is accessed.

Reports

Multi-Level Bill Reports
To generate the report, choose Print Preview from the File menu.

Report Description
Lists all bill of material information for your parent item.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Multi-Level Bill

Fields
Buyr

Buyer code is used to identify the person responsible for handling the purchase of the item. 
The suggested entry is the buyer's initials. Entry is any alphanumeric combination of up to 3 
characters. 

Where Used: A/P Receiving Detail; ABCR; APIE; APII; APIR; APPI; APPO; APPV; AVII; 
AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/Planner Code Maintenance; 
Contract Header Detail; Contract Purchase Orders; Contract Summary; Custom Product 
Detail; CWIP; Demand Peg Detail; IORD; IPPD; Item Browse Detail; Item Master; Item Master 
Planning Detail; Item Responsibility Assigned Results; ITHC; Lead Times Assigned Results; 
Line Item Details + Custom Product; Material Shortages Detail; MBIL; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PCST; PICI; PICK; Picklist Detail; 

Report Title

Multi-Level Bill of Material
Lists all bill of material information for your parent item.
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POAN; POAS; POCI; POCP; POCR; POCT; POMI; POMT; PORI; PORV; Production; 
Purchase Order Header Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; QUOI; QUOT; SDAB; SSII; Standard Costs Assigned Results; 
Summarized Bill; VDSC; VPFR; Where Used; WIPR; Workcenter Master

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Component Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
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Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Component Effectivity Date
Component Effectivity Date is the date used to determine which components on the bill of 
material to display for the specified parent. If the Component Effectivity Date is blank, all 
components on the bill of material, regardless of their in and out effectivity dates, are 
displayed for the specified parent. The Component Effectivity Date display format is 
workstation specific, which is defined as the Short Date setting in the Regional Settings within 
the Control Panel. Default is the current date.

Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Component Effectivity Date
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.
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C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Costed Bill Detail; CPMT; CSLB; Custom Product Component Detail; CWIP; Demand Peg 
Detail; Engineering; Job Estimates and Performance Report; Location Index; Material 
Shortages Detail; MBIL; MCST; Multi-Level Bill; OPSL; Order Cost Variance Status; OVAR; 
PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of Material 
Report; Summarized Bill; WIPL; WIPR

Cum LT
Cumulative Lead Time is the number of shop days to manufacture an item from start to 
finish—from initially placing a purchase order for raw material through each level in the 
product structure to completion of the item. Cumulative Lead Time is based on the critical 
path of components in the item's multi-level bills of material and the component lead times.

Where Used: Multi-Level Bill
Manufacturing Analysis 61



Fourth Shift Release 8.00 Multi-Level Bill
Desc
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Drwg
Drawing number identifies an engineering document that provides design specifications for 
an item. Entry is any alphanumeric combination of up to 30 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Engineering; Item 
Browse Detail; Item Master; Item Master Detail; MBIL; Multi-Level Bill; Multi-Level Where 
Used; Production; QUOI; QUOT; Router/Traveler; Shortages by Order; Single-Level 
Configuration Bill of Material Report; Summarized Bill; Where Used

Effective Rev
Effective Revision Level identifies the revision level of a bill of material. Revision level 
identifiers are embedded in bills of material using items with a predefined Pt Use prefix, such 
as "Rev", and are displayed based on the selected Effectivity Date of the parent item. 
Effective Revision Level = Multiple if more than one revision of the bill of material is 
displayed or if the effective in and out dates overlap.
Manufacturing Analysis 62



Fourth Shift Release 8.00 Multi-Level Bill
Where Used: Bill of Material; Comparison Bill; Comparison of Summarized Bills; Multi-Level 
Bill; Multi-Level Costed Bill; Multi-Level Where Used; Summarized Bill; Where Used

Fixed LT
Fixed Lead Time is the number of working days required for setup and queue time used in 
planning an order. It is added to run lead time and inspection lead time to estimate planned 
lead time for an order. Entry is up to 3 numbers.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; IPPD; Item 
Availability; Item Browse Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-
Level Bill; Multi-Level Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill 
of Material Report; Where Used; Workcenter Master

In Effectivity
In Effectivity is the date that the use of a component becomes effective in a bill of material. 
The default value is today's date or the date you entered when you signed onto the system.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Comparison of 
Summarized Bills; Costed Bill Detail; Demand Peg Detail; Engineering; Exceptions; Location 
Index; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; 
Single-Level Configuration Bill of Material Report; Summarized Bill; Where Used; WUSE

In Rev
In Revision Level indicates the level of documentation for which the parent-component 
relationship becomes effective. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production

Item
Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an 
assembly or finished product. All items are set up using the ITMB screen. Within a product 
structure, an item can be a component as well as a parent. Entry is any alphanumeric 
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge 
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of 
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT; 
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of 
Summarized Bills; COMT; Contract Item Detail; Contract Item Detail/Pricing; Contract 
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order; 
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand 
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment 
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report; 
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INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; Item Lot Trace and 
Serialization Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item 
Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI; 
Lead Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Lot Detail; 
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot 
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing 
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT; 
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance 
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner Item 
Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT; PORI; PORV; 
POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing 
Maintenance + Items/Customers; Pricing Maintenance + Test Order; Production; Purchase 
Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/Traveler; 
Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers Shipped; 
SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item; Shipping 
Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned Results; 
Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; 
VDSC; VEIT; Vendor/Item Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Level
Item Level indicates the position of an item within a product structure. Level is used to show 
the relative position of an item in relationship to its higher-level parent or lower-level 
components. Entry is any alphanumeric combination.

Where Used: CMLB; Location Index; LOTR; MBIL; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE

LT
Lot Trace indicates whether lot number control is used throughout the manufacturing process 
to track the use of the item.

Y = Yes. 
The item is lot-controlled.

N = No. 
The item is not lot-controlled.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; Lot Trace; MPSR; MPSS; Multi-Level Bill; Multi-Level Where 
Used; Production; SSII; Summarized Bill; Where Used; WUSE

LT Offset
Lead Time Offset is the number of days after the order start date that a component is needed 
in the manufacturing process. Entry is up to 3 numbers. Default value is 0.
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Where Used: BILL; Bill of Material Detail; Demand Peg Detail; Lead Time; Lead Time 
Analysis; Material Exposure; MBIL; Multi-Level Bill; Multi-Level Where Used; Production; 
Single-Level Configuration Bill of Material Report

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.

S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Out Effectivity
Out Effectivity is the first date that a component is not effective in a bill of material. The 
default value is 12/31/2079.

Where Used: BILL; Bill of Material; Bill of Material Detail; Comparison Bill; Costed Bill 
Detail; Demand Peg Detail; Engineering; Exceptions; Location Index; Multi-Level Bill; Multi-
Level Where Used; MUSE; Production; Single-Level Configuration Bill of Material Report; 
Where Used; WUSE

Out Rev
Out Revision Level indicates the level of documentation for which the parent-component 
relationship is no longer in effect. It is for information purposes only and is not used by the 
system. Entry is any alphanumeric combination of up to 2 characters.

Where Used: Bill of Material Detail; Comparison Bill; Engineering; Multi-Level Bill; Multi-
Level Where Used; Production
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Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Pln Pol
Planning Policy is used to determine the type of demand an item generates for its 
components based on planned orders. The codes are:

N = Normal. 
Planned and released orders for this item produce "normal" dependent demand for its 
components.

P = Production Plan. 
Planned orders for this item produce a "production forecast" for its components. 
Orders cannot be released for this item. 

F = Final Assembly. 
Planned and released orders for this item create "final assembly" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

D = Distribution. 
Planned and released orders for this item produce "distribution" demand for its 
components. This policy is reserved for future use and is treated like a Planning 
Policy = N by the system.

M = Master Scheduled. 
Planned and released orders for this item produce "normal" dependent demand for its 
components. Planned orders must be manually scheduled within the item's Plng Fnc 
(planning fence).

It is recommended that you only use the "N" code until the master planning capability is 
installed in your system.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; IORD; IPPD; Item Browse 
Detail; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level Where Used; 
Production; Summarized Bill; Where Used

Plnr
Planner code is used to identify the person responsible for planning the production or usage 
of an item. The suggested entry is the planner's initials. Entry is any alphanumeric 
combination of up to 3 characters.
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Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Buyer/
Planner Code Maintenance; Custom Product Detail; CWIP; Demand Peg Detail; IORD; IPPD; 
Item Browse Detail; Item Master; Item Master Planning Detail; Item Responsibility Assigned 
Results; ITHC; Lead Times Assigned Results; Line Item Details + Custom Product; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Shortages Detail; MBIL; MCST; MOAN; MOMI; MOMT; MORI; MORV; MPSR; MSCF; MSMT; 
Multi-Level Bill; Multi-Level Where Used; ORST; OVAR; PICI; PICK; Picklist Detail; 
Production; Purchase Order Line Item Detail; QUOI; QUOT; Router/Traveler; SDAB; 
Shortages by Order; Single-Level Configuration Bill of Material Report; SSII; Standard Costs 
Assigned Results; Summarized Bill; Where Used; WIPR; Workcenter Master

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
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MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Ref Des Count
Reference Designator Count is the total number of unique reference designator identifiers 
entered as Reference Designators associated with a component. For example, the 
Reference Designator Count = 3 for reference designators entered as a range of D1-D3 for a 
specified component.

Where Used: Bill of Material; Comparison Bill; Multi-Level Bill; Where Used

Reference Designators
Reference Designators are unique identifiers which allow engineers to assign control 
information such as device callouts to a component within a Bill of Material. Ranges can be 
used to organize multiple sequential reference designator identifiers. Entry is up to 10 
characters.

Where Used: Bill of Material; Comparison Bill; Engineering; Exceptions; Multi-Level Bill; 
Where Used

Rev
Revision Level identifies a level of documentation which specifies the item's design. It should 
be incremented for each change in the item's design specifications. Entry is any alphanumeric 
combination of up to 2 characters.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail; 
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item 
History; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT; 
Multi-Level Bill; Multi-Level Where Used; PBCI; PBCT; Production; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; Summarized Bill; Supply Peg Detail; Where Used
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Run LT
Run Lead Time is the average number of shop days required for a manufacturing run or 
vendor lead time and is used in planning an order. Run Lead Time is added to fixed lead time 
and inspection lead time to estimate planned lead time which serves to time order release. 
Decimal places for fractional days allowed. MRP Planning uses fractional days as reference 
and plans using the next whole day increment. For example, if you specify Run LT = 2.1, MRP 
Planning assumes Run LT = 3 for calculation purposes. Entry is up to 8 numbers.

Note: Lead times established for an item are considered to be 0 when the item is used as a 
phantom (CT = P) in a bill of material.

Where Used: AVII; AVIT; BILI; BILL; Bill of Material; IPPD; Item Availability; Item Browse 
Detail; Item Master; Item Master Planning Detail; MBIL; MSMT; Multi-Level Bill; Multi-Level 
Where Used; Production; QUOI; QUOT; Single-Level Configuration Bill of Material Report; 
Where Used; Workcenter Master

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Total LT
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
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Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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Lead Time
The Lead Time tab allows you to view cumulative and individual lead times for an item's multi-level product 
structure in effect as of a user-specified date. You can also simulate lead time changes, including changes 
to the start times as specified by a component's lead time offset. 

The Lead Time tab also allows critical path analysis. You can interactively walk the critical path adjusting 
lead times and lead time offsets while monitoring the impact of simulated changes on the cumulative lead 
time of the parent. 

The Lead Time tab displays parent and component item information in a graphical hierarchy on the left 
side and the related lead time information in a Gantt chart on the right side.

The Lead Time tab is only available from the Multi-Level Bill of Material and its functionality is the same 
regardless of how it is accessed. See also Access Methods for more information on accessing this feature.

The Gantt Chart has several display features:

• Daily time increments are displayed by the horizontal axis. Chart scaling is displayed along the 
top of the chart.

• Each component is displayed by one line:

• The starting point of a line, represented by the right vertical line, indicates when the 
component is needed. This date is based on lead times of higher-level items to determine 
when a component's parent item should be started.

• The critical path of components to manufacture the parent item is displayed with red lines by 
default. When more than one critical path exists, only the last one (nearest the bottom of the 
Gantt chart) is displayed in red. Critical paths are marked with an asterisk (*) in the graphical 
hierarchy.

• The normal, highlighted and critical path line colors can be customized by selecting Options 
from the View menu.

• The cumulative lead time for the parent item, based on the critical path of components, is 
displayed in the Cum LT field.

Reports

Lead Time Reports

Line Type Description

Solid single buy item

Solid double make item with a normal component type (CT = N)

Dashed double a make item with a phantom component type (CT = P)

Line length Component's lead time
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To generate the report, choose Print Preview from the File menu.

Quick Print Reports
To generate the report, choose Quick Print from the File menu.

Lead Time Analysis - Full Gantt Chart
Report Description
Graphical representation of the lead time analysis detail plus gantt chart.

Access Method
To generate the report, choose Quick Print from the File menu. 

Report Template
This report is not a template-based report.

Available From
Lead Time

Lead Time Analysis Changes
Report Description
Lists items which have modified lead times or lead time offsets. Several report formats are 
available: Full Gantt, Critical Path Gantt, and Lead Time/Lead Time Offset Changes Only.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Lead Time

Fields
Component

Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 

Report Title

Lead Time Analysis Changes
Lists items which have modified lead times or lead time offsets. Several report 
formats are available: Full Gantt, Critical Path Gantt, and Lead Time/Lead Time 
Offset Changes Only.

Report Title

Lead Time Analysis - Full Gantt Chart
Graphical representation of the lead time analysis detail plus gantt chart.
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be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

LT Offset
Lead Time Offset is the number of days after the order start date that a component is needed 
in the manufacturing process. Entry is up to 3 numbers. Default value is 0.
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Where Used: BILL; Bill of Material Detail; Demand Peg Detail; Lead Time; Lead Time 
Analysis; Material Exposure; MBIL; Multi-Level Bill; Multi-Level Where Used; Production; 
Single-Level Configuration Bill of Material Report

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

Pt Use
Point of Use is a key field that, along with the Seqn field, defines the sort sequence of 
components in a bill of material. The Point of Use field accepts any information you choose to 
enter, but the intended use is to identify the "work center" where the component should be 
delivered when assembling the parent, the "find number" of the component referenced on the 
drawing for the parent, or the "component reference designator" of the component on a printed 
circuit board. If the Point of Use field is not applicable in your company, you may enter 0 
(zero). Entry is any alphanumeric combination of up to 5 characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; Capacity Planning; 
Comparison Bill; Custom Product Component Detail; Demand Peg Detail; Dispatch List; 
Engineering; Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; 
LRRP; Material Shortages Detail; MBIL; Multi-Level Bill; Multi-Level Where Used; MUSE; 
Order Cost Variance Status; OVAR; PICI; PICK; Picklist Detail; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Router/Traveler; Schedule Board; Single-Level Configuration Bill of Material Report; TRUD; 
Where Used; WUSE

Seqn
Sequence Number is a key field that, along with the Pt Use field, defines the sort sequence of 
components in a bill of material. The field accepts any information you choose to enter, but the 
intended purpose is to identify the operation sequence number on the parent’s routing that 
calls out the component. If the Sequence Number is not applicable in your company, you may 
enter 0 (zero). Entry is up to 3 numbers.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; Capacity Planning; CINV; COCP; Comparison Bill; CPMT; Custom Product 
Component Detail; CWIP; Demand Peg Detail; Dispatch List; Engineering; Exceptions; Job 
Estimates and Performance Report; Lead Time; Location Index; LRRP; Material Shortages 
Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; MUSE; OPSL; Order Cost 
Variance Status; OVAR; PCST; PICI; PICK; Picklist Detail; PORI; PORV; Production; 
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Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchased 
Component Detail; Router/Traveler; Schedule Board; Single-Level Configuration Bill of 
Material Report; TRUD; Where Used; WIPL; WIPR; WUSE

Total Lead Time
Total Lead Time is the sum of Run LT, Fixed LT and Insp LT as expressed in shop days.

Where Used: Bill of Material; Lead Time; Lead Time Analysis; Multi-Level Bill; Multi-Level 
Where Used; Summarized Bill; Where Used
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Material Exposure
The Material Exposure button allows you to view lead time information with material exposure detail. 
Material Exposure is the buildup of product cost over the lead time of a selected parent item. By analyzing 
material exposure, you can determine the source of excessive early costs and therefore reduce on-hand 
inventory. You can also quantify the maximum investment required to shorten a product's lead time by a 
fixed number of days.

Material Exposure displays cost totals on the left side and a graphical cost buildup representation on the 
right side. The related component information is also listed in a table format.

The Material Exposure button is only available from the Lead Time tab on Multi-Level Bill of Material. See 
also "Access Methods" in the Engineering manual for more information on accessing this feature.

Reports

Material Exposure Reports
To generate the report, choose Print Preview from the File menu.

Quick Print Reports
To generate the report, choose Quick Print from the File menu.

Report Description
Lists a graph of the time-phased cost buildup as well as the detail for components within the 
specified lead time.

Access Method
To generate the report, choose Print Preview from the File menu. 

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System 
Help topics.

Available From
Material Exposure

Material Exposure Profile
Report Description
Graphical representation of the material exposure detail.

Report Title

Material Exposure
Lists a graph of the time-phased cost buildup as well as the detail for compo-
nents within the specified lead time.

Report Title

Material Exposure Profile
Graphical representation of the material exposure detail.
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Access Method
To generate the report, choose Quick Print from the File menu. 

Report Template
This report is not a template-based report.

Available From
Material Exposure

Fields
Available Qty

Available Quantity is the user-defined formula used to calculate the quantity available for the 
purpose of fulfilling the simulated Prod Qty. Available Quantity is increased when the 
following are selected:

On-hand (O)
In-Inspection (adjusted for yield) (I)
On-Hold (H)
In WIP (W)
In shipping (S)
On-Order (R)

Available Quantity is decreased when the following is selected:

Allocations from other orders (A)
The Available Quantity definition is displayed using the abbreviations in parenthesis. The 
default calculation is:

[On-Hand + (In-Inspection * Yield)] - (Allocations from other 
orders)

Where Used: Material Exposure; Summarized Bill

Component
Component is a term that describes the structural relationship between an item and its parent 
assembly in a bill of material. A Component is used in the manufacture of a parent, and it may 
be a part, raw material or a subassembly. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE
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Costs Per Assembly
Cost Per Assembly is the total cost of the item used to produce the parent.

Where Used: Material Exposure

CT
Component Type distinguishes various types of relationships between a component and its 
parent assembly in a bill of material. The Component Type indicates how a component is 
used in the manufacture of a parent. The Component Types are:

N = Normal. 
Component is consumed in the manufacture of its parent.

P = Phantom. 
Component is used for structure purposes only (e.g., a transient subassembly 
consumed in the manufacture of its parent).

R = Resource or Workcenter. 
Component is used in the planning process of the manufacture of its parent (e.g., 
labor hours).

X = Reference. 
Component is for information purposes. Reference items are included on the picklist. 
Reference items are not included in the parent's rolled costs and are typically not 
required for issue in the manufacturing of the parent.

D = Document. 
Component is used for information purposes only. It is not included on the picklist.

B = By-product. 
The manufacture of the parent results in the creation of this component.

C = Co-product. 
Component is derived from the manufacture of the parent. The manufacture of the co-
product, in turn, produces the parent.

T = Tool. 
Component is used in the manufacture of the parent.

U = Tool return. 
Component is used in, and returned after, the manufacture of the parent.

M = Module. 
Component represents a group of components for which requirements are generated 
for custom product orders. A module component is used for structure purposes only, 
such as a transient subassembly consumed in the manufacture of its parent. Module 
components explode requirements for the child components; the module component 
itself is never required.

V = Purchased material. 
Component not defined on the Item Master is required for a custom product customer 
order.

W = Outside operation or service. 
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Component, such as heat treating or plating, is required for a custom product 
customer order.

Y = Phantom parent. 
Requirements have been exploded to the next level to meet requirements.

Z = Phantom child. 
Component is used in the manufacture of the phantoms parent.

An item's use as a component is limited by its Item Type.  The Component Types available 
are based on the information displayed on the screen and not all types are available on all 
screens.

Where Used: Backflush Issue Reconciliation Report; BILI; BILL; Bill of Material; Bill of 
Material Detail; CMLB; COCP; Comparison Bill; Comparison of Summarized Bills; Costed Bill 
Detail; CPMT; CSLB; Custom Product Component Detail; Demand Peg Detail; Engineering; 
Exceptions; Job Estimates and Performance Report; Lead Time; Location Index; Material 
Exposure; Material Shortages Detail; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; 
Multi-Level Where Used; MUSE; OPSL; OVAR; PCST; PICI; PICK; Picklist Detail; Production; 
Router/Traveler; Single-Level Configuration Bill of Material Report; Summarized Bill; Where 
Used; WUSE

Cumulative Cost
Cumulative Cost is the calculated costs incurred to build the parent item through the lead 
time day specified.

Where Used: Material Exposure

Description
Item Description identifies the item in terms of its characteristics. When space is limited, a 
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV; 
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup 
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill; 
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV; 
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail; 
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP; 
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory 
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD; 
ISVI; ITBI; ITCB; ITCI; Item + Alternates; Item + Quantity; Item Availability; Item Availability + 
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Trace and Serialization 
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Item Responsibility 
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report; 
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Item Details + 
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot 
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order 
Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST; 
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; 
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Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order 
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging 
Detail; Partner Item Detail; PBCI; PBCT; PBII; PICI; PICK; Picklist Detail; POAN; POAS; 
POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production; Purchase 
Order Line Item Detail; Purchase Order Line Item Detail (CPMT); Purchase Order Line Items; 
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line Item; Shipping Detail; 
Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; 
Standard Costs Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg 
Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

LT Days
Lead Time Days is the number of days into the production of the parent item.

Where Used: Lead Time Analysis; Material Exposure

LT Os
Lead Time Offset is the number of days after the order start date that a component is needed 
in the manufacturing process. Entry is up to 3 numbers. Default value is 0.

Where Used: BILL; Bill of Material Detail; Demand Peg Detail; Lead Time; Lead Time 
Analysis; Material Exposure; MBIL; Multi-Level Bill; Multi-Level Where Used; Production; 
Single-Level Configuration Bill of Material Report

Make / Buy Cost
Make / Buy Cost is the user-defined formula used to calculate the Total Cost for make and 
buy items. Cost definitions for make and buy items can include the following costs:

Material (M)
Labor (L)
Variable overhead (V)
Fixed overhead (F)

The Make / Buy Cost definition is displayed using the abbreviations in parenthesis. 

Where Used: Material Exposure; Summarized Bill

MB
Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code 
also directs appropriate action messages to the Buyr (B or S) or Plnr (M). Make-Buy Codes 
are:

M = Make. 
Manufactured in-house.

B = Buy. 
Purchased; no parts supplied to vendor.
Manufacturing Analysis 80



Fourth Shift Release 8.00 Material Exposure
S = Supplied. 
Purchased; parts supplied to vendor.

Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP; 
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item 
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Item 
Master; Item Master Detail; Item Master Planning Detail; Item Responsibility Assigned 
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned 
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material 
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; PBCT; Production; 
QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of Material 
Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg Detail

Parent
Parent is a term that describes the structural relationship between an item and its components 
in a bill of material. A Parent item is the higher level item in the parent-component relationship. 
A parent cannot be used in itself. Entry is any alphanumeric combination of up to 30 
characters.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; Comparison Bill; 
Comparison of Summarized Bills; Cost Estimate by Lot Size; CSLB; Dispatch List; 
Engineering; Lead Time; Lead Time Analysis; Location Index; Material Exposure; MBIL; Multi-
Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; MUSE; Production; Summarized 
Bill; Where Used; WUSE

% of Cost
Percent of Cost is the calculated percentage of the costs incurred to produce the parent item 
at a specified lead time day in relation to the total cost to produce the parent item. The 
Percent of Cost calculation is Cumulative Cost/Total Cost.

Where Used: Material Exposure

QT
Quantity Type code defines the nature of the parent- component relationship when placing an 
order for the parent. It affects how the Quantity field is used in calculating component 
requirements. Quantity Types are: 

I = Per Item. 
Quantity per item is the number of components needed to manufacture one parent 
item. For a given order, the gross number of components required equals Quantity 
times order size. 

O = Per Order. 
Quantity per order is the number of components required per order to manufacture 
one or more parent items. For a given order, the gross number of components 
required equals Quantity.
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Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; COCP; Comparison Bill; 
Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; Demand Peg Detail; Engineering; Job Estimates and Performance Report; 
Location Index; Material Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Where Used; 
MUSE; OVAR; PCST; Picklist Detail; Production; Purchased Component Detail; Summarized 
Bill; WUSE

Quantity
Quantity Required specifies how many or how much of a particular component is required to 
manufacture a parent. Entry is up to 10 numbers. Decimal places are allowed.

Where Used: BILI; BILL; Bill of Material; Bill of Material Detail; CMLB; COCP; Comparison 
Bill; Comparison of Summarized Bills; Costed Bill Detail; CPMT; CSLB; Custom Product 
Component Detail; CWIP; Engineering; Job Estimates and Performance Report; Material 
Exposure; MBIL; MCST; Multi-Level Bill; Multi-Level Costed Bill; Multi-Level Where Used; 
MUSE; PCST; Production; Purchased Component Detail; Single-Level Configuration Bill of 
Material Report; Summarized Bill; Where Used; WIPL; WIPR; WUSE

Scr Pcnt
Scrap Percent is the amount of scrap (specified as a percent of component quantity required) 
that is normally generated for the component item during the manufacture of its parent. Entries 
must be less than 100 percent and a decimal point must be entered for tenths or hundredths of 
one percent. For example, enter 3.5 for 3.5%. A decimal point displays for whole numbers 
even though the decimal point does not have to be entered. For example, enter 2 for 2%, 
which actually displays as 2.0. Default value is 0.

Where Used: BILL; Bill of Material Detail; Costed Bill Detail; Demand Peg Detail; Material 
Exposure; MBIL; OVAR; Production; Single-Level Configuration Bill of Material Report

UM
Unit of Measure identifies the standard unit for an item used in the manufacturing process. 
Entry is up to 4 alphanumeric characters.

Where Used: A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV; 
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of 
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail; 
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB; 
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order 
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail; 
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB; 
ITCI; Item + Quantity; Item Availability + Quantity; Item Browse Detail; Item History; Item Lot 
Receipt; Item Lot Trace and Serialization Detail; Item Master; Item Master Detail; Item Master 
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB; 
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead 
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index; 
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; 
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material 
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Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order 
Completion Status; Order Cost Variance Status; Order Detail; Order Line Items; OVAR; 
Packaging Detail; Packing List; Partner Item Detail; PBCI; PBCT; PCST; PICI; PICK; Picklist 
Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR; POVD; Pricing 
Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing Maintenance + Test 
Order; Production; Purchase Order Line Item Detail; Purchase Order Line Item Detail (CPMT); 
Purchase Order Line Items; Purchase Order Receipt History; Purchased Component Detail; 
QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line 
Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order; SHPL; Single-Level 
Configuration Bill of Material Report; SSII; SSIL; Standard Costs Assigned Results; Standard 
Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; 
VEIT; Vendor/Item Detail; VETI; VPFR; Where Used; WIPR; Workcenter Master; WUSE
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Product Structure Detail
From the bill of material features, you can review product structure detail. Product structure detail includes 
production item detail, item history and lot trace detail. The following tabs are available:

• Production. Includes component detail, references, planning detail, planning fence and stock 
status.

• Item History. Includes an item's inventory history and activity information.

• Lot Trace. Includes an item's lot trace and serialization details.

Production
The Production tab allows you to enter component detail, references, planning detail, planning 
fence and view stock status.

The Production tab is divided into sections that include:

Item History
The Item History tab allows you to view an item's inventory history and activity information.

The Item History tab displays beginning, receipt, issue, shipping and adjustment quantities.

Lot Trace
The Lot Trace tab allows you to view an item's lot trace and serialization detail information. 

The Lot Trace tab is divided into sections that include:

Tab Title Description

Comp Detail Allows you to enter engineering or production component detail such as in and 
out revision dates. Component specific notes may also be entered. Available only 
from the Production Bill of Material or Production Where Used features.

References Allows you to view classification information, such as item class codes and family 
grouping, to further define the item. All entries are optional and should be used if 
your company requires a detailed record for the item

Packaging Allows you to view specific shipping and packaging information, such as shipping 
weight or package type, to further define the item. All entries are optional and 
should be used if your company requires a detailed record for the item.

Planning Detail Allows you to view planning information, such as preferred location and lead 
time. Used as key references by the system to make planning calculations.

Planning Fence Allows you to view planning information, such as forecast codes and lot size 
quantities. Used as key references by the system to make planning calculations.

Stock Status Allows you to view an item's current inventory status. Provides information on the 
quantity for each inventory classification (on hand, in-inspection, shipping, on-
hold and internal and external WIP) and inventory value based upon ITMC Cost 
Type Ø.

Tab Title Description

Detail Allows you to view an item's lot trace and serialization detail information. Pro-
vides information such as policies, calendar days and text messages.
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Lot / SN Allows you to view an item's lot trace and serialization number detail. Provides 
information such as lot and serial mask, default and last number used.

Tab Title Description
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